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service  District Mission

excerence  \We build new clubs and support
all clubs in achieving excellence
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Chief Judges Workshop
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Unmute Start Video

1. Except for the presenter, all other attendee's mic

will be kept in muted condition, to avoid

disturbances.
2. Please post your questions if any, in chat facility to - &
' @
Q&A Host.
. —

District 116, Qatar November 19t" 2020
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Chief Judges Workshop

Welcome Address
and
Open the session

Thayalan Kailayapillai, DTM
District Director
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Chief Judges Workshop

The Big Picture

Rajeswar Sundaresan, DTM
Past District Director
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The Picture
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Chief Judges
Training

SUNDARESAN RAJESWAR, DTM
Past District Director
District — 116 Qatar



Why learn to be a Chief Judge? TOASTMASTERS

CHIEF JUDGE
TRAINING

"Learn, Level-Up,

Lead!™

Find and Keep Your
llWhyl'

“He who has a why can

f Y 8in

Follow us @districtll6

endure any how" -
Nietzche



Why learn to be a Chief Judge?

An opportunity to practice & improve:
» Organizational skills

» Motivational skills

> Abllity to think on your feet

» Virtual event management

Integrity-the sense of conscientious

Respect- Meet and work with Toastmasters

outside your club
Service- Ensure that contests are fair

Excellence- Learn to use theoretical

knowledge in practice

TOASTMASTERS

INTERNATIONAL

Please realize that you
can make a difference in
someone’s life today.

And it will make a
difference in your own,
as you do.



TOASTMASTERS

PREAMBLE: Speech Contest Rulebook

The Speech Contest Rulebook is
a protocol and applies to all
official Toastmasters Speech

contests. Modifications to rules

may only be made through the
administrative protocol review
process.

: ] SPEECH CONIES]
Exceptions are not permitted. RULEBOGK.

LY 1, 2020 TO

30, 2021

TTTTTTTTTTTT

WHERE LEADERS
ARE MADE




TOASTMASTERS

PREAMBLE: Online Speech Contests

Online Speech Contest
Best Practices

2020-2021 Toastmasters Contest Cycle

For 2020-2021, all Districts must
conduct online Area/Div./Dist.-level
contests, with each contestant
participating from physically-
distant locations, using equipment

he obtains.

All contestants and contest officials
must be present in real time and
must use a webcam and
microphone to ensure they are
visible and audible.




Speaking is an art, cannot be

measured with scientific objectivity, Is Judging
h | v subiecti process a
ence largely subjective.
J=Y =0 challenge?
Contest speech has set of criteria 3 e .

with weightage. The scoring is an
objective process, based on a
subjective experience.
Judging is both subjective & objective.
dJudging can be quite a challenge,
assessing the difference between a

series of speakers in quick succession.




ATTRIBUTES OF A CHIEF JUDGE TOAETIRSTERS

AFFILIATIVE:
(TEAM- TRUST- TRIUMPH)

ACCOUNTABLE:
(KNOWLEDGE- KNOW HOW-
KINDNESS)

ALERT:
(PUNCTUAL- PROCESS-
PREDICATE)




TOASTMASTERS

Who appoints the Chief Judge?

» At a club contest, VP-Education (if
not a contestant) or Contest Chair

» At Area/Division/District; Contest
Manager

Who appoints Judges?

» Chief Judge

» Contest Manager may mobilize the
judges for Chief Judge

» Chief Judge must verify that the
judges are eligible and qualified for
that level, as per rules

» Chief Judge appoints tie breaking
Judge




TOASTMASTERS

INTERNATIONAL

Who appoints the Timers and Ballot Counters?

» Chief Judge

» Contest Manager may mobilize

the role players on behalf of the
Chief Judge

» Chief Judge must verify and
ensure that role players are
eligible and qualified, as per
rules




TOASTMASTERS

INTERNATIONAL

» Club Level:
= Be a Paid Member

» Area, Division, District;
= Be a Paid Member for a minimum of 6 Months

= 6 Project’s from CC Manual (Only members who joined prior to the roll out of Pathways in
the Region Mar. 18 can apply for CC) Or Completion in Level 1 and 2 of any path in the
Pathways

» Regional QF & WCPS SF & Finals:

= Be a Paid Member for a minimum of 6 Months
= Advanced Communicator Bronze Or have completed at least One Path in the Pathways
= Have previously judged Speech contest at Area/ Division/ District or semi final Level

» Member still competing or intends to compete beyond the club level
(anywhere) for the same category not eligible.




TOASTMASTERS

Judges and Role players R

At each level of a Toastmasters speech contest, a specified number of voting judges and
officials are required.

" LEVEL T o= VOTING JUDGES o | TIMER | BALLOT
COUNTERS
i ' |
CLUB MINIMUM 5 | 2 | 2
e - e i —— - . Ml_ﬁl_m-ljh E — R - ! - - ]
AREA An equal number of judges from each club in the 2 2
AREA
W = T i By . el = o o - =
DIVISION | An equal number of judges from each AREA in the | 2 | 2
Division. ;
The chief judge, voting judges, and the tiebreaking judge must not | |
be a member of any club in which a contestant is a member. | i
|
[ S SR MINIMUM 7 Gl i N |
DISTRICT | An equal number of judges from each DIVISION in the 2 . '
District. |
The chief judge, voting judges, and the tiebreaking judge must ‘
not be a member of any club in which a contestant is a member. | ‘




TOASTMASTERS

CHIEF JUDGE -DUTIES

PICK THE (A) WINNER (1.2.3)

2. ENSURE CONTEST IS CONDUCTED FAIR
(Contestants/ Other Toastmasters/ Public)

3. RESOLVE PROTESTS & DISQUALIFICATIONS

4. BEWARE & OVERSEE ALL THAT HAPPENS
DURING THE CONTEST

PEOPLE HAVE FUN




CHIEF JUDGE RESPONSIBILITIES TONETIRSTERS

1. Appoint and counsel voting judges,
counters, timers, and a secret
tiebreaking judge.

2. Act as chief counter. Appoint counters
and provide with the Counter’s Tally
Sheet

3. Encourage contest officials to view the
online Contest training
www.toastmasters.org/tlc

4. Conduct Judges’ briefing for voting
judges, counters, and timers



https://www.toastmasters.org/~/media/f1586830529047b5a2325167b925d4b1.ashx

General Rules TOASTMASTERS

» Rulebook applies to all Contests at all levels
= Slight category-specific differences.

» Contest to happen, even if only one contestant!
» Role-Players not to compete in the event at which they serve.
» Chief Judge’s role: Does not participate in Judging.

» Protests: “Eligibility” or “Originality” or Reference another contestant, or a
speech presented by another contestant from the platform at the same
contest they are competing

» Disqualifications of Contestants:
= Absence at beginning of Contest (not allowed to contest)
= Time Limits (not eligible to win and/or progress to next level)

(d One Member, One Area Contest of a Given Type!



TOASTMASTERS

CASE STUDIES INTERNATIONAL

R R AR T e G
TR

> Evaluation contestants must not know the test e
speaker. A contestant met someone It turned 5 : : -
out as test speaker.

> An area Contest Manager had won her club’s
speech contest but was not allowed to compete § & i

In the area contest

» One contestant appeared from two clubs
belonging to two Areas and went to two
Divisions




Nothing ever goes
away until it teaches us
what we need to know.

~“Pema Chodron




Chief Judges Workshop

Planning
and
Execution

Shyam Sundar

District 116, Qatar

November 19th 2020



Chief Judges Training: Planning & Execution

Presenter. Shyam Sundar

District 116 19 November 2020
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Content

d Preparation - Checklist

1 Orientation - Prior to contest day

3 Briefing — On the contest day m

d In action - During the contest

n

d Handling - Technical Glitches / Interruptions

District 116, Qatar November 19t" 2020



Preparation

O Checklist:

» Eligibility check. Finalized Judges & Role Players contact details

» Coordinate - date, time, Zoom ID of the contest

» Contest chair, Ballot counters, Timers, Zoom Host

» Distribute forms (Printed sheets recommended)

Judges Guide & Ballot

Judges Certification of Eligibility & code of Ethics (fillable)
Speech Contest Rule book

Best practices for online speech contests by T

Online speech contest procedure and guideline by District 116

Speech contest time record sheet

TOASTMASTERS

INTERNATIONAL

Eligibility

v / Criteria

District 116, Qatar

November 19th 2020



TOASTMASTERS

INTERNATIONAL

Preparation

O Checklist:

» Have these ready with you

= Counter's Tally Sheet

= Notification of Contest Winners

= Result Form

= Signed Judges Certification of Eligibility & code of Ethics Judges
= Role players list with contact details

» Plan orientation date and time prior to contest EI |g| bl I |ty

» Contingency Plan — for all role players including chief judge \//Cntena
» Chief Judge, Judges, Timers will use Laptop/PC/Mac only. No Mobile

No Tablet/iPad

District 116, Qatar November 19t" 2020



Before the Contest Day (2 days prior)

U Orientation / Dry Run - Online Contest Format
» Voting & Tie Breaking Judges
» Timers
» Ballot Counters
» Contest Chairs .

{
» Contest Manager ‘ “ ‘ f‘

» Zoom Host & Co-Hosts

District 116, Qatar November 19t" 2020



Before the Contest Day

O Orientation / Dry Run - Online Contest Format
» Invite all judges, Timers, Ballot counter, Host, Co-Host, Contest Chair and Contest Manager
» Familiarize all with online contest procedures and etiquettes.

= Zoom meeting room login & entry

= Breakout room entry & exit,

= Basis of online contest judging

= Naming convention and Anonymity

= Stay attentive, No break, No distraction.

= Video off, audio muted, stable Internet connection (multiple devices)

= Submission of ballot to chief judge & Communication

District 116, Qatar November 19t 2020



Before the Contest Day

O Orientation / Dry Run - Online Contest Format

» Discuss the judging procedures like

Read the Rule Book & Judging Criteria
Login with your zoom credentials earlier than briefing
Setting of speaking area, body language, gestures, eye contact

Ignore video and audio quality

Ignore audience response for Humorous speech contest
reparatlon |s the key

One method for one contest " O I
Don’t time, Don't evaluate, Don’t get opinionated, Just pick\

the winners

District 116, Qatar November 19t" 2020



Before the Contest Day

O Orientation / Dry Run - Online Contest Format

» Discuss the judging procedures like

Consider only “Today’s"” Performance!
Rank 1st, 2" and 34 Winners (Except Tie-breaking Judge)
Type/Write your name, sign and transmit to Chief Judge

Incase of Technical Glitch, responding / rebounding plan

Limitations on online contest format

reparation is the key

Protest procedure NNAA A

District 116, Qatar November 19t" 2020



Before the Contest Day

O Orientation / Dry Run - Online Contest Format

O Tie-Breaking Judge:

» Maintain Confidentiality (should not attend judges briefing)
» If needed, CJ can brief the TBJ separately

» All aspects applicable to voting judges apply to TBJ as well
» Rank ALL Speakers (NOT just the first three)

» TB Ballot will be used only in case of a Tie!

TOASTMASTERS

INTERNATIONAL

District 116, Qatar

November 19th 2020



Before the Contest Day

O Orientation / Dry Run - Online Contest Format

O Timer:

>

>

2 Nos.

Timer 1 : Official Timekeeper — Timer Sheet — Chief Judge
Timer 2 : Display Timer — Virtual background — backup
Technical glitch — responding plan

Review of Virtual Background, Naming convention

Start of timing — Discuss with contest manager

|dentify time disqualification

Timer 1 — Transmit time recording sheet — chief judge

District 116, Qatar

November 19th 2020



Before the Contest Day

U Orientation / Dry Run - Online Contest Format

(] Ballot Counters

>

>

>

>

>

>

2 Nos / 3 for district.

Discuss the mechanism of tallying — Online

Breakout room before and after contest

Attentive during the result announcement — Intervene if required
Maintain confidentially all times

No record of tally sheet

WS
W
T

District 116, Qatar

November 19th 2020
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Before the Contest Day

O Orientation / Dry Run - Online Contest Format
U Contest Chair

» Agree on the procedure of contest conduct.

» Agree on contestant introduction and winner announcement
» Discuss and familiarize with procedures during technical glitch
» How/Who Table Topics will be displayed (TT Contest)

» Conduct a dry run with Contestants — agree on speaking area, basic checks

District 116, Qatar November 19t" 2020



TOASTMASTERS
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Before the Contest Day

O Orientation / Dry Run - Online Contest Format

U Zoom Host / Co-Host

>

>

Agree on the procedure of contest conduct.

Discuss on the breakout room, allowing judges, contestant and role players —

Prior contest begins

Discuss on the procedures — Technical Glitch
Agree on communication ‘
Provide a list of judges and role players with naming convention

Co-host assisting ballot counters

el
ZOOIM

Co-host assisting briefing/holding rooms

District 116, Qatar November 19t" 2020



On the Contest Day

O Briefing

» Brief all judges, Role players — check naming etc
» Have a quick refresher
» Discuss any changes on that day

» Refresh on communication protocol

» Remain anonymous all times “even after contest”. Change name after the contest

District 116, Qatar

November 19th 2020



TOASTMASTERS

INTERNATIONAL

On the Contest Day

O During the Contest . . .
If something is not right,
» Ensure fairness to all contestants

Halt the Contest, Fix it immediately!
» Stay attentive, vigilant and monitor contest

» Keep an watch on judges, display timer, audience

» Intervene self if necessity arises.

» Have contact list handy and be in touch with role players

privately.

» Clarity, be decisive, act timely

District 116, Qatar November 19t" 2020



On the Contest Day

U During the Contest

O Monitor the zoom meeting room
» Entry & Exit of Guests
» Audio/Video distractions
» Recording of Proceedings
» Contest Chair:
v'Contestant Introductions

v’ Announcement of Table Topics

District 116, Qatar

November 19th 2020



Handling - Technical Glitches / Interruptions

0 Contestants part

d Glitch before speaking

» 15 seconds to rebound ‘ ‘ ‘ ‘

» Move to the last and advance others

O Glitch during the speech

» Pause the speech & timing. &A)

» Note where paused and when

o7

» 30 seconds to rebound + 30 seconds grace period

» |f unable to rebound, judged as per the rule book and timing guidelines

District 116, Qatar November 19t 2020



Handling - Technical Glitches / Interruptions

0 Contestants part
U Disqualification
» Contestant absent when contest chair is introduced
» Contestant fails to appear during the speaking turn
» Contestant unable to turn on the camera and unmute mic in breakout room (TT/Evl)

» Contestant isn't physically alone in the breakout room (TT/Evl)

District 116, Qatar November 19t 2020



Handling - Technical Glitches / Interruptions

O Contest Organizers Part
d Glitch before/during speaking
» |f affects more than one contestants, CJ may reschedule or restart

» If affects any one of contestant in TT/Evaluation contest, CJ may restart the contest

O Glitch after the last speaker
» Judging, tallying proceeds as normal.

» Winner Announcement could be rescheduled

District 116, Qatar November 19t" 2020



Slyam Suncdar

District 116, Qatar

November 19th 2020
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Chief Judges Workshop

Finalizing
and
Announcing of Winners

Venketesan Kulandaivelu

District 116, Qatar November 19t" 2020



Chief Judges Training: Finalizing & Announcing Winners

Presenter: Venkatesan K

District 116 19 November 2020
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INTERNATIONAL

Objective

To explain the process of tallying the
ballots and announcing the contest
winners {to the virtual context}.




Chief Judge’s Role

Contest Manager / Chair Chief Judge

Appoint Qualify Identify
Prepare Chief Judge Rulebook (Train, Judge) (Role-players)
Contestants Judges Timers CJS:I'::lers

Briefing
Eligibility Originality Tie-Breaker Eligibility SAA

Contest Monitor

Announce Tally
ifi Protest
Contest Certificates Results rotests




Chief Judge’s Role after the contest

> Collect the ballots from all the judges thru’ ballot counters

» Collect the report from the TIMER

> Tally the ballots with the support of Ballot Counters

» Handle the Protest; if any

> Fill the result notification form and send it to the contest chair

> Fill the winner's notification form and send to the contest manager

> Ensure the winners are announced properly in order, as per the result



Things to Remember

TOASTMASTERS

INTERNATIONAL

» Attend the contest through a Laptop or desktop. Not through a mobile phone

>

Ensure you have a decent internet connection and AV is checked

Enable Web-WhatsApp in your system

Keep all the role-players contact details {Judges, Timers, Ballot counters, Contest Chair}
Keep the Result from and Winners notification forms ready with you.

Be familiar with the Excel Sheet ( Ballot Counting- Tally Sheet)

Double check the result form with the Tally counters; prior to share with the Contest Chair




Tally Counting Process

> Host to enable the Breakout room for Ballot Counting { Assign CJ, BC1 & BC2 }
> Join the Breakout room assigned for Ballot counting
- i If you missed the notification, click here and join the breakout room
_> 7~ O\
The host is inviting you to join - - ol - = 1 |
Breakout Rooms: Judges Briefing 'I -.l ! - - - I:g} [ | |
Room Security Participants Share Screen Record Preakout Rooms
Joining Breakout Rooms... ~
Later Join Judges Briefing Room
This may take a few moments. A L 1 £
Judge’s Official Ballot - Table Topics™ Contest pei b e
Mame of Contestant PLACE RANKING POINTS
» Collect the report from the TIMER through WhatsAp - e
» Collect the report from the JUDGES through WhatsA|
> CJ shall share the screen to display the Tally excel sheet & Web WhatsApp



Judge’s Ballot & Timers Report

SPEECH CONTEST TIME RECORD SHEET
AND INSTRUCTIONS FOR TIMERS

ey by

Feie oSt lain i

et

St

AT ] il M i

Tabis ol

Lintamrmm

Tall T e

TOASTMASTERS

INTERNATIONAL

Judge’s Official Ballot - Humorous Speech Contest Ao
Mame of Contestant PLACE RANKING POINTS
. N for counters use only)

First Place: First Place 3 points
and Place: )
Second Pla Second Place 2 points
Third Place:
e Third Place 1 point
El f WET, a5 |

Ensure the ballots are signed and the Judges name are written in BLOCK letters



Tally Sheet in Excel

BALLOT COUNTERS' TALLY SHEET

Date:

Contest

Club #

Area # Division# District#

Ehiad vtbadima nell g piis it pha Safior Cncneans sdamannie st for sataning s soons fom e gatiper Sadions & po racons
ineai o, Fane The ofiaddagims haloens dhe Snalinfonmadion faom S Shesd b0 S804 &7 Heae 0Rnens ST SmanT i
wipdia andgualiiad contastant, The Halancs of e sfommaiion & conidaniial and ot o ba mada acadabia a7 genecal formation.

COUNTER’S
TALLY SHEET

Give this completed tally sheet to the chief judge. f judge provides the chair the names and places of al
contestants. The balance of the information is confidential and not to be made available as general information
Name of
Contestant
Name of Judge
3
5
&
]
o
|
Totals
enter on this tally sheet:

e fotals,

disqualified by the chief judge for speaking under-time or overtime,

king Judge's Ballot.

announce the

From each ballot collected. enter on this tally sheet:

a. 3 points for FIRST place

b. 2 points for SECOMND place c. Tpoint far THIRD place

After results from all ballots have been entered, compute totals.

Name of Contestant

- - - - - = - - - =
= = = =1 = =1 = = = =

Judge 1

Judge 2

Judge 3

Judge 4

Judge S

Judge B

Judge 7

Judge 5

Judge 3

Judge 10

Totals - - = - - - -

Check the Timer's Keport, [

overtime, strike their names from the results.

Dizgqualifified on Time F'ES)

any contestants were disqualified by the chief judge for speaking under-time or

IF & tie results, refer to the
Tiebreaking Judge’s Ballat.

Dizqualifified on Qriginalits M+'ES

Rank YWinners

Enter winners as follow s:

1st Place Winner

2nd Place YWinner

3rd Place Winner

Microsoft Excel
Worksheet



Screen Sharing & Filling the Tally Sheet

BALLOT COUNTERS' TALLY SHEET

Date: | |Cuntest

Club # Area # Division# District#

Liuind dndzes willshans i vt s Sadior Sincrdans sloironieally For Snbaning e moones fom e gadpes Aadiaer & a0 pacoed
ngaaliicationg Fany The chisfiadias shal cena tha Snalinfonmation Fom $s shes o ideniils qo b0 #hines nunases From among s
Sfipia and gaifod vontostant Fhe badanes of the iafoanation i coniidaniial and not ko Ho mada avadabis as sanaraliinformaiion,

From each ballot collected. enter on this tally sheet:

a. 3 points for FIRST place b. 2 points for SECOMND place c. 1paint for THIRD place

Aler results from all ballots have been entered. compute totals.

Mame of Contestant - ~ - - w = - = - =
= = = = = = = = = =

Judge 1

Judge 2

Judge 3

Judge 4

Judge 5

Judge &

Judge 7

Judge 3

Judge 3

Judge 10

Totals - = = = - - - -

Check the Timer’s Keport. If any contestants were disqualified by the chief judge for spealung under-time or
overtime, strike their names from the results.

Disqualifified an Time [YES)

If a tie results, refer to the
Tiebreaking Judge’s Ballat.

Diis qualifified on Originalivy (YES

Rank ¥Winners

Enter winners as follow s:

1st Place Winner

Znd Place Winner

3rd Place Winner

TOASTMASTERS

INTERNATIONAL

CJ & Ballot Counters must be familiar with this excel sheet
Keep this excel sheet and Web WhatsApp open in your system

() Select a window or an application that you want to share

Basic Advanced

L

iPhene/iPad

-

Share computer sound

776300 Investigation Report - No.‘.m CJ Training -

DWO016-P01 - Envirenmental Per...

D116 Online Speech Contest Proc...

Optimize Screen Sharing for Video Clip

Files

19112010-Venkat - Pm Ballot Counter Sheet for Demo 0[‘ Online Cont:

—
|
est- Venkat - PowerP... m

View Options

>nt folders (11)

Bandicam memefaces
I This PC\Bocuments 1] This PC\Downloads
Vv
Google Drive This PC
Kavitha Q Deskeop

-
= Sereenshots

This PC\Pictures

tfiles (20)

October Civics Chap 6 and 7 Notes
part2

Zoom Ratio  Fit to Window >
Request Remote Control

Exit Full Screen

Stop Participant's Sharing

=l
Audacity Desktop
This PC\Documents ! This PC

This PC\Downloads

This PC\Downloads

rea#
drawings ‘GHIC
Kavitha )

al iy

Pictures
e rmat

-

TC1- Shreya V is requesting remote
control of your screen

You can regain control at any time by clicking on your screen.

te totals.




Breaking the Tie

» Refer Tie-Breaking judge’s ballot
» Compare results of only “Tied” contestants.

» Higher placed contestant in Tie-Breaking judges ballot

TOASTMASTERS

INTERNATIONAL

Don’t use tiebreaker ballot
unless
there is a tie

wins
Sl Tie-Breaking Judge’s Ranking
» Tally Counters Ranking

1.  Ahmed & Gil Tied

5 Susan 1: Susan

3. Yoosaf 2: Philip

3: Ahmed

» Final Result 4: Yoosaf

1.  Ahmed 5 Gil

2. Gil

3. Susan

4 Yoosaf (does not place)

Scenario 2

» Tally Counters Ranking
1. Philip
2.  Susan & Yoosaf Tied
5. Gil

> Final Result

1. Philip

2. Susan

3. Yoosaf

4 Gil (does not place)




Notification forms

P

S -._
Eo-:m.-.ls'[:n:- Results Form

4

Instructions
Chief Judge

Contest Chair

Time Dizqualifications

Oves Owo

Announce rment
THIRD place winnar
SECOMD place winnar

FIRST placa winmer

Share with the Contest Chair

OASTMASTERS
NOTIFICATION OF INTERNATIONAL

CONTEST WINNER

Place MName Club No. Email Address Telephone

List "All" qualified contestants in the Winners Notification form

Share with the Contest Chair for the next level contest

End Meeting for All

Leave Meeting

Leave Breakout Room




TOASTMASTERS

INTERNATIONAL

Winners Announcement

()
( ) = |mmediately interrupt the contest chair & Hold the

STAY announcement
ALERT

If the announcement of the winners by = Correct the order should be or why a contestant should
the contest chair is incorrect or in the not be identified as a winner.
wrong order, only the Chief Judge,
ballot counter or timer can bring the
error to everyone's attention.

Privately tell the contest chair and the Chief Judge about
the correction needed.

.; Except the Result Form & Winner Notification form, delete all other
Dot documents from your WhatsApp and Laptop after the winner

!
Forgf”  announcement.



Know the Rules
Conduct a pre-event communication/meeting with all role layers

Agree upon the mode of collecting the reports ' \ i
Familiarize with the tally sheet \ } [ N

Ensure the tally counting by repeated checks
Multitask - Strategically
Have a contingency plan 4,

Take assistance from the host/Co-host for technical matters



Thank You
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Chief Judges Workshop

Protest Procedure
and
Situation-based Quiz

Surya Narayanan, DTM

District 116, Qatar November 19t" 2020



Division B, District 116
Chief Judges Training

Protests & Scenarios-Based Quiz

Surya Narayanan K, DTM
19t Nov., 2020



Contest Process...

Contest Manager / Chair Chief Judge

Appoint Qualify Identify
Prepare Chief Judge Rulebook (Train, Judge) (Role-players)
Contestants Judges Timers CJS:?lers

Briefing
Eligibility Originality Tie-Breaker Eligibility SAA

Contest Monitor

s Cerlificates Announce Tally
Contest Results Results




Mana -

Criteria: Process:

v" Paid Member in a good standing Club in the Area, v" Judges or contestants can protest to CC/CJ
Division, and District in which he or she is v" Check online for Member / Club status
competing. v" Check progress through the contest cycle

v' 6 CC Projects or Pathways L1 & L2 for International v° Contest Chair can take decision on Disqualification,
Speech (exception Charter members) in consultation with Chief Judge.

v' Maintain eligibility at all levels of any contest

Originality
Criteria: Process:

v Certified as “Substantially original” by member v Judges or contestants can protest to CC/CJ

v" Twenty Five percent or less may be devoted to v All Voting judges to be present to handle protests
Quoting and/or Paraphrasing v Discuss the matter with Judges, including proof

v" Any quoted material must be identified. v Provide opportunity for Speaker to defend

v Judges Vote to decide on Disqualification
v Majority vote is required to disqualify!

Referencing Other Contestants

Criteria: Process:
v"  Contestants must not reference another contestant, Judges or contestants can protest
or a speech presented by another contestant, from All Voting judges to be present to handle protests
the platform at the same contest in which they are Discuss the matter with Judges, including proof
competing. View the recording to confirm, if needed
Provide opportunity for Speaker to defend
Judges Vote to decide on Disqualification
Majority vote is required to disqualify!

AN NN Y NN




SCENARIO-BASED QUIZ



TOASTMASTERS

INTERNATIONAL

Memb%rﬁh u%aﬁ%;mlumb 222 & Club 333, both in Area 99. He wins a speech

contest from Club A and goes on to win at Area 99.All this happens by March.
However when Division Contest happens in April, Club A is not in good standing
(less than eight paid members), though X has paid his dues for both Club A &
Club B.

QO Is X eligible to take part in the Division Contest?

0 Would the eligibility change if Club B is not in the same Area/ Division?

2. Eligibility

A To be eligible to compete in any official Toastmasters speech contest, a member
Mmust:

1. Be a paid member of a club in the Area, Division, and District in which he or she is
competing.

a) The club must also be in good standing.

D) A new, dual, or reinstated member must have dues and membership applica-
tion current with World Headquarters.
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Eligibility jn:Area G@testser of club 666 & club 999 in two

different Districts. Can he talk part in contests in both clubs?

8. Toastmasters who are members in more than one (1) club and who meet all
eligibility requirernents are permitted to compete in the club contest{s) in each
Club imwhich they hold paid membership.

a) No contestant can compete in more than one (1) Area speech contest of a given
type, even if the two (2) Areas are in different Divisions or Districts.
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More than.one rgle st official? Can a member serve in more than one
such role in the same contest?

The following are the contest officials: Contest Chair, Contest Toastmaster,
Event Committee Chairs, Chief Judge, Voting Judges, Tiebreaking Judge,
Timers, Sergeant at arms, and Counters. In case of online contests, Host is
also a contest official.

https://www.toastmasters.orqg/Footer/[FAQ/Speech-Contests

10. Contest afficials must not serve in more than one (1) role for the same contest at the
Area (when practical), Division, District, region quarterfinal, semifinal, and final levels.

dPage # 10
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Contestant %una%rﬁ&'@nwﬁy%rﬁ Contest in his club. Can he

be the Contest Chair for International Speech Contest in the
same club?

Yes, as long as the contest where the member is competing and the contest where the member is serving as a contest chair are not at the
same event.

Example: Jane Doe is competing at District G's annual conference in the Tall Tales Contest. She cannot serve as a contest chair for any
contests at District G's annual conference.

Jane is not competing in District F's annual conference. Jane Doe can serve as a contest chair for any contest at District F's annual
conference.

https://www.toastmasters.orqg/Footer/[FAQ/Speech-Contests
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Same Club,.chief, Voting and/or Tie-breaking judges be from the same
club as a Contestant?

> It is okay at club level, but preferably avoided. Even in that case,
conflict of interest must be avoided.

2. At area contests, there shall be an equal number of voting judges from each club
in the area, or a minimum of five voting judges. In addition to these voting judges,
a contest chair, chief judge, tiebreaking judge, three counters, and two timers shall
be appointed.

3. At division contests, there shall be an equal number of voting judges from each
area in the division, or a minimum of seven voting judges. In addition to these
voting judges, a contest chair, chief judge, tiebreaking judge, three counters and

Res two timers shall be appointed. No chief judge, voting judge, or tiebreaking judge
> Pag'- shall be a member of any club in which a contestant is a member.
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Table TOPri%ea Director attends the TT contest in one of the clubs in

his area. He insists that he shall only provide the topic for the
contest. Is he right?

Table Topics Contest Rules

The Table Topics Contest follows all rules outlined in the General Rules section of this
rulebook. In addition, the following additions and exceptions apply.

1. All contestants must receive the same topic, which must be of a general nature.

A. The topic is selected by the contest chair.
» Page # 18
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Table Topigs official TT contest, the Contest Chair presents a picture
without wordings and asks the contestants to speak about the
same. Is that allowed?

Table Topics Contest Rules

The Table Topics Contest follows all rules outlined in the General Rules section of this
rulebook. In addition, the following additions and exceptions apply.

1. All contestants must receive the same topic, which must be of a general nature.
» A The topic is selected by the contest chair.

R eSS w1 not require a detailed knowledge, and

must lead to an opinion or conclusion.
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Evaluatioy Gantestiber of club 777 & Club 555. TM Y is a member of
Club 555. Can Y be the Test Speaker in the Evaluation Contest of
Club 777, where TM X is a contestant?

C. 1t is SN 2t at all levels of the contest, the Toastmaster giving the test
speech not be a member of the same club as any one of the contestants.

» Page # 17
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Chief Judges Workshop

Q & A Session

Facilitators

District 116, Qatar

November 19th 2020



Chief Judges Workshop

Closing Remarks

Manzoor Moideen, DTM
District Program Quality Director
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